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Overview

QuickBooks is a great accounting system with many features that, when utilized to their
potential; provide a robust accounting and financial reporting system when integrated with
BuildTopia. The purpose of this document is to describe how best to integrate BuildTopia and
QuickBooks to provide the best total solution.

In terms of the integration itself, BuildTopia has a module, commonly referred to as LinkTopia
that manages the exporting of transactions from BuildTopia to QuickBooks. Further QuickBooks
has a standardized import function that import transactions within I1F Files. LinkTopia creates
these IIF Files, based on a pre-defined format, that are then imported into QuickBooks.

From an accounting and book-keeping perspective, QuickBooks manages financial reporting,
accounts payable, banking, cash management, non-direct costs, and payroll; and BuildTopia
manages all aspects of Direct Construction Costs and Sales including payment approval and
deposit management.

The approach described in this document is considered a recommended approach based on
research of the features of both QuickBooks and BuildTopia. While this document speaks to a
proposed integration and workflow that describes how to best take advantage of some of the
features within QuickBooks, many customers are successful integrating both BuildTopia and
QuickBooks differently than what is described herein. The reader should understand that there is
considerable flexibility in the integration of the two systems and further that LinkTopia can be
modified to support different export structures and integration methodologies to support varied
customer requirements.

A description of the primary touch points between BuildTopia and QuickBooks is described herein
and includes:

1. Accounts Payable Processing
2. Job Costing and Profitability
3. Settlement & Closing Entries
4. Financial Reporting

Accounts Payable Processing

The purchasing process related to Direct Construction Costs is managed entirely in BuildTopia.
Purchase Orders are generated and ultimately approved in BuildTopia. The PO approval step in
BuildTopia is intended to act as the payment approval point and thus only approved PO
transactions are sent over to QuickBooks.

Purchase orders are approved in BuildTopia and sent over to QuickBooks as Accounts Payable
Bills. The General Ledger (GL) entry for each transaction is a Debit to Work in Process (WIP) and
a Credit to Accounts Payable (AP). The default setup is a single AP and a single WIP account for
all transactions. For reconciliation purposes, it is recommended that a dedicated Work in Process
account be created to manage direct costs exclusively from BuildTopia.

Relating to AP payment processing, there are two generally accepted principles relating to the
payment process that are both supported — “auto pay” or match PO’s to vendor invoices.

If a builder does “auto pay”, then all approved PO’s from BuildTopia would be approved for
payment and no additional processing is necessary to pay out of QuickBooks.

If choosing to match vendor invoices to Bills sent over from BuildTopia, it will be important to
establish a method to discern bills in QuickBooks that have and have not been reconciled to
vendor invoices — in this case the user will only pay bills that have been reconciled. A
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methodology to make this differentiation could include entering/updating the following fields
when vendor invoices are reconciled to QuickBooks Bills coming in from BuildTopia:

1. Update “Bill Due” field in QuickBooks for only reconciled invoices. Bills originating out of
BuildTopia will not have a value in this field.

2. Update “Memo” field in QuickBooks to include the vendor invoice number. Bills
originating out of BuildTopia will have the Lot # in the Memo field so the user could add
this following the Lot # entry.

Job Costing in QuickBooks

In addition to being able to perform detailed job costing functions within BuildTopia, the
QuickBooks — BuildTopia integration can be setup to support summarized and detailed job
costing and profitability analysis at the project level, building level and lot level within
QuickBooks. The job costing capabilities utilize QuickBooks customer, job and item classifications
pursuant to the following parameters.

For Single-Family builders, job costing and profitability is analyzed at both the project and lot
level. QuickBooks customers are BuildTopia projects, QuickBooks jobs are BuildTopia Lots/Units,
and QuickBooks items are BuildTopia cost codes. QuickBooks also supports grouping of cost
codes into cost categories using their Item / Sub-Item capabilities.

For Multi-Family builders, profitability is analyzed at the project, building, and unit level. In this
scenario, QuickBooks customers are BuildTopia projects, QuickBooks jobs are the aggregation of
BuildTopia units within a building (aggregated by Lot Accounting Code in BuildTopia) and
QuickBooks items are BuildTopia cost codes. Further, QuickBooks supports the concept of sub-
jobs allowing job profitability analysis to support a Project — Building — Unit hierarchy (Customer
— Job — Sub Job).

Based on the above configurations, project profitability is provided in QuickBooks using the Job
Profitability Report functions. QuickBooks’ Profitability Reports summarize revenue, cost and
profitability for each job (lot/building) and aggregates that information by customer (project).
QuickBooks Detail Profitability Reports provide detailed costs breakdown by item (cost codes)
with profitability by job (lot/unit/building).

Please note that since only approved transactions are being sent over to QuickBooks, only
BuildTopia will have data as it relates to all committed costs, including open purchase orders, and
cost to complete.

Closing Entries

When homes/units are settled, journal entries need to be made to recognize revenue and
corresponding costs of sales (closing journal entry). The elements of closing entries may include
the following.

1. Revenue: Base House, Options, NSO, Land

2. Cost of Sales: Base House, Options, NSO, Land
Settlement Expenses

Construction Loan Payoff

Deposits: Base House and Options
Commissions

Settlement Proceeds

50 af O J—Ld

Work In Process: Indirect and Direct Costs, including Base House, Options, NSQO's, Variances
and Cost to Complete
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Closing entries are dependent upon reports out of QuickBooks and BuildTopia. Depending upon
the needs of your organization relating to how financial reports break down revenue and costs of
sales, the corresponding information can be pulled out of either or both systems.

In many cases, what will be required to report from BuildTopia is the “cost to complete” and the
breakdown of revenue and costs that correlate to the desired P&L structure (i.e. revenue and
Cost of Sales breakdown of Base House, Options, & NSQO’s).

Cost to complete is the outstanding committed costs that have not been sent over to QuickBooks
from BuildTopia. For QuickBooks customers, the open purchase orders that have not been
approved within BuildTopia will not be recorded in QuickBooks at the time of the Closing Journal
Entry. Thus, at the time of the closing entry, open purchase orders that have not been approved
on the corresponding lot should be reported out of BuildTopia On-Demand Reporting™. The
balance of these purchase orders can be included as an adjustment in the Closing Journal Entry.

For builders that desire to have their P&L breakdown revenue and cost of sales by Base House,
Options and NSQ's, it is recommended to utilize the Job Cost Variance Report in BuildTopia to get
the corresponding breakdown of cost information and ensure that all related costs are accounted
for. For the revenue side the best method to group your information is to create a custom on-
demand report using the Sales-Workups dataset within BuildTopia.

Financial Reporting

Using the above methodologies, QuickBooks can nicely support different styles of financial
reporting where management can see financial reports summarized the way they want to see
them and get detail from the QuickBooks job profitability functions, in addition to the detail
available from BuildTopia.

It is recommended that cost code detail not be retained on the Profit & Loss Statement, but
rather maintain that detail through QuickBooks job profitability reporting functions.

Another feature of QuickBooks is the concept of a “Class” that provides the ability to group and
classify transactions. The default QuickBooks setup includes a mapping of the BuildTopia Project
to the QuickBooks Class thereby supporting the capability to break out financials by Project.

Quickbooks Classes can be
used to breakout financials by
Project.

[ 2 A
Project 1 Project 2 Project 3 Project 4 Total % of Sales

Revenue

Base House Revenue $18,630,000 $3,498,935 $9,350,080 $13,360,574 $44,839,589 72%

Options Revenue $4,140,000 $777,541  $2,077,796  $2,969,016  $9,964,353 16%

NSO Revenue $3,105,000 $583,156  $1,558,347  $2,226,762 $7,473,265 12%

Less Discounts & Incentives $64,688 $12,149 $32,466 $46,391 $155,693 0%

Total Revenue $25,875,000 $4,859,632 $12,986,222 $18,556,353 $62,277,207 100%
Cost of Sales — Direct Costs

Base House Direct Costs $12,161,250 $2,284,027 $6,103,524  $8,721,486 $29,270,287 47%

Options Direct Costs $2,587,500 $485,963  $1,298,622  $1,855,635 $6,227,721 10%

NSO Direct Costs $1,811,250 $340,174 $909,036  $1,298,945  $4,359,404 7%

Total Cost of Sales — Direct Costs $16,560,000  $3,110,164  $8,311,182 $11,876,066 $39,857,412  64%
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Configuration Considerations & Settings

Master Configuration and Data Structure

BuildTopia recommends that the following structure be reflected in both your QuickBooks and
BuildTopia configurations.

QuickBooks Data BuildTopia Entry

Vendor Vendor Accounting Code (or if blank, Vendor Name)
[Lists > Vendor Lists] [Data Library > Trade Partners > Edit]
Customer Project Accounting Code

[Lists > Customer: Job List] [Admin > Projects > Modify]

Job Lot Accounting Code (or if blank, Lot Number)
[Lists > Customer: Job List] [Project Setup > Lots > Lot Details]

Item Accounting Code 1 (or if blank, Cost Code Number)
[Lists > Item List] [Data Library > Activities > Cost Codes > Edit]
Class Project Accounting Code

[Lists > Class List] [Admin > Projects > Modify]

BuildTopia contains accounting codes for Projects, Companies, Vendors, Lots, and Cost Codes.
The data in these codes controls the mapping within QuickBooks. The above cross reference
refers to the LinkTopia Export Structure called “QuickBooks — BT.” The following are some
considerations to make when defining your coding structure:

0 QuickBooks Profitability Reports only show the Item Code within QuickBooks. Therefore
the item codes should include both a code and a name (i.e. 1020 Permits & Fees).
Therefore the entire code must also be in the BuildTopia Cost Code Accounting Code.

0 QuickBooks supports a convention of sub-items and sub-jobs. In both cases, the
mapping requires both the category and the subcategory in the corresponding BuildTopia
field. For example: Item Category of 10 Pre-construction and Item Code of 1020
Permits & Fees needs to have the following value in the BuildTopia Cost Code Accounting
Code:

10 Pre-construction:1020 Permits & Fees

The same methodology applies for jobs and sub-jobs and the corresponding value
required in the Lot Accounting Code in BuildTopia.

0 In cases where transactions are imported into QuickBooks and values for the Vendor,
Customer, Job, or Item do not exist, QuickBooks will automatically create the entry in
QuickBooks using the value provided in the LinkTopia file. However, this method of
data-building is not recommended. In certain situations, Quickbooks will assign incorrect
data characteristics to undefined values in the LinkTopia file. For example, if a
Customer/Job Name has not been preset in Quickbooks and a transaction is imported
using the unlisted Name, Quickbooks will automatically create the intended Customer/Job
Name as a Vendor Name.

0 While Accounting Codes for Vendors, Lots and Cost Codes are not necessary, the
respective fields can be used to support QuickBooks centric naming conventions or a
coding structure in QuickBooks that may not exactly correlate to BuildTopia. It is
mandatory that the data that is populated in both the Quickbooks lists and BuildTopia
data fields match exactly. This will insure that imported transactions are assigned and
classified correctly in Quickbooks.

BuildTopia — the most widely used web-based construction management software for homebuilders.
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QuickBooks Versions Supported

Currently the LinkTopia interface supports any PC version of QuickBooks capable of imports of IIF
files. Unfortunately, due to differing functionalities, BuildTopia does not currently support
imports of IIF files into QuickBooks versions for Apple Macintosh®. According to the QuickBooks
web-site, the following versions of QuickBooks have this capability:

QuickBooks 1999 — QuickBooks 2007 (Premier Industry-Specific or Enterprise editions are
recommended)

LinkTopia Setup

Overview

During the export process, LinkTopia gathers any purchase orders that match the criteria
established either in the LinkTopia setup process or in the Advanced Export process, and which
have a new purchase order status of “Approved” since the last LinkTopia export was completed.
Approved purchase orders that have not previously been included in a LinkTopia file will be
exported in one IIF file.

LinkTopia does not export open purchase orders, budgets or estimates for import into
QuickBooks. In QuickBooks, there is no method to append or update an estimate, or void an
open purchase order through an import file and thus are not sent over to QuickBooks.

LinkTopia also has a user interface to manage previous exports from BuildTopia. Users have the
ability to view previous exports and re-export any transactions based on user defined queries.

Configuring LinkTopia to achieve the integration described in this document requires 3 settings to
be made within the LinkTopia Setup function within BuildTopia.

1. Specify Accounting Package: QuickBooks
2. Specify Export Format: Approved PO Format (QB A 007)

There are multiple QuickBooks Interfaces supported by BuildTopia, the integration
described in this document requires the specific interface noted above. In the case of a
custom LinkTopia Interface, it would be selected here.

While LinkTopia can send over additional data, there is no mechanism within QuickBooks
to maintain other data and thus only approved transactions are supported in the
recommended interface. The Open PO Format an Void PO Format fields should be set to
“Do Not Export.”

3. Specify General Numbers for Work in Process (WIP) and Accounts Payable (AP).

Be sure to use GL numbers not names. One of the most common causes of integration
errors is the use of text names and not account numbers. QuickBooks has the flexibility
to operate without Account Numbers — so if there are none on the current Chart of
Accounts, it is recommended that they are added and then entered in BuildTopia. Also,
the Purchase Order Account Name is not utilized in the recommended configuration.

BuildTopia — the most widely used web-based construction management software for homebuilders.
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LinkTopia Configuration - 3 Settings to make

1. Specify “Quickbooks” Package. )
2. Specify the “QB A 007" Format for
Approved POs only.
{ ; i Home | Repol Admin | Data Library | Acct | Messages | Help | My Profile | Log Out
= y RS .
e ” . Welcome Wendi Pannell
Home > Linktopia » Linktopia Settings

| | — saw ]
Export Formats
Package Quickbooks
Open PO Format 5o Nat Expart
Approved PO Format QB A 007
Void PO Format Do Not Export
[ check here if you need to use a pay date in your exports.
(A @t (oo B e e i e oy e et o e et 3. Specify GL Account
[ Check here if you would like to export sach projact in separate files Numbers (not names) for

AP and WIP. PO
Account Name is not
used.

QuickBooks Settings
Accounts Payable A it Name

Determine the Account Names
Navigation Path

QuickBooks > Lists > Chart of Accounts
Steps

Examine the chart of accounts list. Note the appropriate account name and number (as
appropriate) for the following account types:

0 Accounts Payable
0 Work-in-Progress
0 Purchase Orders (This is not used and can be left blank)

LinkTopia is capable of exporting to one account for each account type. If your chart of accounts
currently contains multiple accounts of the above account types, select the appropriate account
to which the BuildTopia data should be imported. It is recommended that all companies have a
dedicated WIP account used exclusively for Direct Costs coming in from BuildTopia in order to
simplify reconciliation of work in process to BuildTopia.

BuildTopia recommends capturing the account number for the account, as account names can be
duplicated. Duplicate account names cause errors during the import process and may cause
issues with your data.

Complete LinkTopia Setup
Navigation Path

BuildTopia > Acct > Setup tab

Notes

This task is limited to users with administrative access to BuildTopia.
Steps

1. Select the “QuickBooks” item from the Package pull-down menu.
2. Select the appropriate purchase order statuses to be exported:

BuildTopia — the most widely used web-based construction management software for homebuilders.
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i. Select the “QB A 007” item from the Approved PO Format pull-down
menu to export Purchase Orders approved for Payment within
BuildTopia.

ii. QuickBooks does not support maintenance of open or void transactions
so do not select these transaction types to be exported.

3. Additional Linktopia Settings:

a. Pay Dates in your Exports: This setting is not used in Quickbooks exports and
should not be selected.

b. Option Codes as Activity Codes: This setting may be used in custom
implementations and should only be selected if instructed to do so by
Professional Services.

c. Export Each Project in Separate Files: This setting may be used in this
integration. If your company uses a separate QuickBooks file for each project,
select the checkbox for the Export Each Project in Separate Files setting. NOTE:
The Project Accounting Code is populated in the project definition, accessed at
the following navigation path: Admin > Projects > Modify link.

4. Use the following text fields to enter the QuickBooks account name or number in the
QuickBooks Settings section:

a. Accounts Payable Account Number
b. Work-In-Progress Account Number

c. Purchase Order Account Number is not necessary and can be left blank or have
“N/A” inserted as the account number.

5. Select the Save button to save the LinkTopia setup changes, or select the Cancel button to
discard the changes.

New Export from LinkTopia
Navigation Path

BuildTopia > Accounting > New Export
Notes

0 Basic Exports can be generated by skipping the filtering functions of the LinkTopia wizard.
Simply select to Preview Export by clicking the on-screen button or using the pull-down
navigation to advance to the preview screen.

Steps
1. To perform a PO Search in LinkTopia:
a. Select the Project Name from the pull-down menu.

b. Use the text field to enter the Payment Date or use the Pick Date link to select
the Payment Date using a calendar view. Manually entered dates must be
entered in the correct format, e.g. MM/DD/YYYY.

c. Select the Next button.
d. Basic Filtering — Enter all or some of the following fields:
i. Use the pull-down menu to select PO Type.
ii. Use the text field to enter the PO Number.
iii. Select the PO Status by checking the appropriate box.

BuildTopia — the most widely used web-based construction management software for homebuilders.
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iv. To filter by an Amount,

1. Use the pull-down menu to select the amount filter type
a. "="-WO/PO amount must equal the amount entered in
the text field.
b. "="-WO/PO amount must not equal the amount
entered in the text field.
c. "<"-WO/PO amount must be greater than the amount
entered in the text field.
d. ">"-WO/PO amount must be less than the amount
entered in the text field.
e. "<="-WO/PO amount must be greater than or equal to
the amount entered in the text field.
f. ">="-WO/PO amount must be less than or equal to the
amount entered in the text field.
2. Use the text field to enter the amount.
v. Use the text field to enter the Lot Sub Accounting Code.

vi. Use the text field to enter the Option/Activity Name.

vii. Use the text fields to enter the From and To Date Created or use the
Pick Date link to select the from and To Date Created using a calendar
view. Manually entered dates must be entered in the correct format,
e.g. MM/DD/YYYY.

viii. Use the text fields to enter the From and To Date Approved or use the
Pick Date link to select the From and To Date Approved using a calendar
view. Manually entered dates must be entered in the correct format,
e.g. MM/DD/YYYY.

e. Select the Next button.
f. Lot Selection — Select Lots to EXCLUDE from the PO search.
i. By default all lots are included in the PO search parameters. To remove
lots from the current PO search:
1. Select the Lot Number(s) from the list.
2. Select the Exclude Selected button.
3. Lots that have been removed from the PO search parameters
may be viewed on the Exclude tab.
ii. If the Lot Selection is incorrect, the Lots on the Include and Exclude tabs
may be reversed by selecting the Inverse Selection button.
Select the Next button.
Trade Partner Selection — Select Trade Partners to EXCLUDE from the PO search.
i. By default all Trade Partners are included in the PO search parameters.
To remove Trade Partners from the current PO search:
1. Select the Trade Partner(s) from the list.
2. Select the Exclude Selected button.
3. Trade Partners that have been removed from the PO search
parameters may be viewed on the Exclude tab.
BuildTopia — the most widely used web-based construction management software for homebuilders. 10
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ii. If the Trade Partner selection is incorrect, the Trade Partners on the
Include and Exclude tabs may be reversed by selecting the Inverse
Selection button.
i. Purchase Order Selection — Select Purchase Orders to EXCLUDE from the export.
i. By default all Purchase Orders are included in the resulting export file.
To remove Purchase Orders from the current export:
1. Select the Purchase Order(s) from the list.
2. Select the Exclude Selected button.
3. Purchase Orders that have been removed from the export may
be viewed on the Exclude tab.
j.  If the Purchase Order selection is incorrect, the Purchase Orders on the Include
and Exclude tabs may be reversed by selecting the Inverse Selection button.
k. Select the Preview Export button.
i. Due to technical limitations, the system will not display all Purchase
Orders for large export files.
ii. The Export Preview is only intended as a final checkpoint for the overall
structure of the LinkTopia export file.
2. Select the Run Export button to export the file in the format appropriate for the accounting
software specified during LinkTopia setup.
3. At the File Download prompt, select the Save button to save the exported file to your hard
drive.
4. In the Export dialog box:
a. Navigate to the desired location where the file should be created.
b. Modify the file name for the exported file as appropriate.
c. Select the Save button to create the new file, or select the Cancel button to stop
the export process.
Import into Accounting System
Navigation Path
2006 — 2007: QuickBooks > File > Utilities > Import > IIF Files
Prior to 2006: QuickBooks > File > Import > IIF Files
Steps
1. In the Import dialog box, browse to the exported file saved in the previous step. Select the
Open button to begin the import process.
In most cases, when an Import Error occurs in QuickBooks, there will be a very non-descript
error message with a Line Number, usually in the format “Error on Line 7”. If you are reporting a
problem with a LinkTopia file importing into QuickBooks, please note the line number that caused
the error.
Re-Export from LinkTopia
Navigation Path
BuildTopia > Accounting > Re-Export
BuildTopia — the most widely used web-based construction management software for homebuilders. 11
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Notes

The LinkTopia interface for re-exports of POs has been updated to mirror the functionality utilized
for New Exports. The only additional search parameters that are included in Basic Filtering for
the re-export interface are Export Date Selection fields and a text field for the Audit Number.

1. To perform a PO Search in LinkTopia:

a. Select the Project Name from the pull-down menu.

b. Use the text field to enter the Payment Date or use the Pick Date link to select
the Payment Date using a calendar view. Manually entered dates must be
entered in the correct format, e.g. MM/DD/YYYY.

Select the Next button.
d. Basic Filtering — Enter all or some of the following fields:

iv.

Vi.

Vii.

viii.

Use the pull-down menu to select PO Type.
Use the text field to enter the PO Number.
Select the PO Status by checking the appropriate box.
To filter by an Amount,
1. Use the pull-down menu to select the amount filter type

a. "="-WO/PO amount must equal the amount entered in
the text field.

b. "I="-WO/PO amount must not equal the amount
entered in the text field.

c. "<"-WO/PO amount must be greater than the amount
entered in the text field.

d. ">"-WO/PO amount must be less than the amount
entered in the text field.

e. "<="-WO/PO amount must be greater than or equal to
the amount entered in the text field.

f. ">="-WO/PO amount must be less than or equal to the
amount entered in the text field.

2. Use the text field to enter the amount.
Use the text field to enter the Lot Sub Accounting Code.
Use the text field to enter the Option/Activity Name.

Use the text fields to enter the From and To Date Created or use the
Pick Date link to select the from and To Date Created using a calendar
view. Manually entered dates must be entered in the correct format,
e.g. MM/DD/YYYY.

Use the text fields to enter the From and To Date Approved or use the
Pick Date link to select the From and To Date Approved using a calendar
view. Manually entered dates must be entered in the correct format,
e.g. MM/DD/YYYY.

Use the text fields to enter the From and To Date Exported or use the
Pick Date link to select the From and To Date Exported using a calendar
view. Manually entered dates must be entered in the correct format,
e.g. MM/DD/YYYY.

BuildTopia — the most widely used web-based construction management software for homebuilders.
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X. Use the text field to enter the Audit Number.
5. Complete the re-export using the previously described steps for New Exports from LinkTopia.
BuildTopia — the most widely used web-based construction management software for homebuilders. 13
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QuickBooks Setup

Because of the complexity and the importance of your accounting system to your company,
BuildTopia recommends consulting your accounting professional prior to making any changes or
modifications to your accounting system configuration.

Creating / Modifying the Chart of Accounts
Notes

BuildTopia recommends entering account numbers as well as account names within the chart of
accounts. In order to allow entry of account numbers, the Use Account Numbers company
preference setting must be selected in QuickBooks via the following navigation path: Edit >
Preferences > Accounting icon > Company Preferences tab > Use Account Numbers.

Navigation Path
QuickBooks > Lists > Chart of Accounts > Account button > New
QuickBooks > Lists > Chart of Accounts > Account button > Edit
Steps
1. Select the appropriate Type from the drop down menu.
2. As appropriate, use the text field to enter the account Number.
3. Use the text field to enter the account Name.
4. If the account is a sub-account of an existing account within the Chart of Accounts:
a. Select the sub-account checkbox.
b. Select the appropriate account from the sub-account pull-down menu.
5. As appropriate, enter the following optional information:
a. Use the text field to enter the Description.
b. Use the text field to enter the Bank Acct No.
c. Use the pull-down menu to select the Tax Line.

d. Use the text field to enter the opening balance for the account. The default
entry is zero.

e. Use the text field or the calendar icon to enter the date for which the opening
balance applies.

f. Select the checkbox to indicate that the account is inactive.

6. Select the OK button to save the new account and return to the list of chart of accounts or
select the Cancel button to return to the list of chart of accounts without saving the changes.
If creating multiple new accounts, select the Next button to create a new account, and then
repeat steps 1 — 6.

Creating / Modifying Items
Notes

0 BuildTopia recommends that items be created to mirror the cost codes (or Cost Code
Accounting Codes) created within the BuildTopia system.

0 The steps for creating / modifying items apply to all item lists including, but not limited to,
vendor lists, customer lists, and the Item list.

BuildTopia — the most widely used web-based construction management software for homebuilders.
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Navigation Path

QuickBooks > Lists > Items List > Item button > New

QuickBooks > Lists > Items List > Item button > Edit

Steps

1. Use the pull-down menu to select the Item Type. Note: In most cases, the Item Type will be
set to Service.

Use the text field to enter the Item Name/Number.
If the class is a sub-item of an existing item:
a. Select the Subitem of checkbox.
b. Select the appropriate Item from the Subitem of pull-down menu.

4. Select the checkbox to indicate if this service is used in assemblies or is performed by a
subcontractor or partner.

5. Use the text field to enter the Item Description displayed on Item purchases entered
manually into Quickbooks.

6. As appropriate, use the text field to enter the Cost for the Item.

7. Use the pull-down menu to select the appropriate Account from the Chart of Accounts.

8. As appropriate, use the pull-down menu to select the Preferred Vendor.

9. Use the text field to enter the Item Description displayed on Item sales entered manually into
Quickbooks.

10. As appropriate, use the text field to enter the Sales Price for the Item.

11. Use the pull-down menu to select the appropriate Account from the Chart of Accounts.

12. Select the OK button to save the new Item and return to the list of Items or select the Cancel
button to return to the list of Items without saving the changes.

Creating / Modifying Classes

Navigation Path

QuickBooks > Lists > Class List > Class button > New

QuickBooks > Lists > Class List > Class button > Edit

Steps

1. Use the text field to enter the Class Name.

2. If the class is a sub-class of an existing class:

a. Select the sub-class checkbox.
b. Select the appropriate class from the sub-class pull-down menu.

3. Select the OK button to save the new class and return to the list of classes or select the
Cancel button to return to the list of classes without saving the changes. If creating multiple
new classes, select the Next button to create a new class, and then repeat steps 1 — 3.
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Troubleshooting

Common Reasons for Import Errors

The following is a list of some common causes of import errors found when importing an iif file
into QuickBooks.

1. Accounts Names are used instead of Account Numbers. Very commonly customers will
use the general ledger account name within LinkTopia and not the account numbers for
work in process and accounts payable. It is highly recommended that builders utilize
account numbers in QuickBooks and put the numbers in LinkTopia rather than the
account names.

2. Accounts Payable general ledger account has to have a GL type of “Accounts Payable”,
not “Current Liability.”

3. Opening an IIF file in Microsoft Excel, then re-saving it, will unknowingly change the
format of the file making it unreadable by QuickBooks — even if you resave it as an IIF
file.

4. If the Vendor, Customer and Item lists (as well as Classes) are not configured so that the
BuildTopia data mirrors the QuickBooks data, imports may result in erroneous data
and/or import errors.

Technical Support

The Customer Support Center provides support for BuildTopia customers for the entirety of the
application including LinkTopia. The Customer Support Center can be reached by telephone at
800.773.0711 or by email at support@buildtopia.com.

If you are still in the Implementation process and the configuration of LinkTopia was included as
part of your implementation, you may also contact your Implementation Manager for support.

In cases where troubleshooting QuickBooks integration errors, customers may be asked to
provide information out of QuickBooks including the Chart of Accounts, Item List, Customer/Job
List, Class List and/or Vendor List. See instructions below on how to extract this information out
of QuickBooks.

Export QuickBooks Data to Send to BuildTopia
Navigation Path

2006 — 2007: QuickBooks > File > Utilities > Export > Lists to IIF Files
Prior to 2006: QuickBooks > File > Utilities > Export
Notes

In the event that you encounter a problem with LinkTopia, or if you require additional assistance
in configuring LinkTopia, it may be necessary to export the chart of accounts and other lists for
submission to BuildTopia staff for review.

Steps

1. Select the checkbox for each list to be exported to an IIF file. The most common lists
requested will be the following:

a. Chart of Accounts
b. Customer List
c. Vendor List
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d. Class List
e. Item List
2. Select the OK button to continue the export process, or select the Cancel button to stop the
export process.
3. In the Export dialog box:
a. Navigate to the desired location where the file should be created.
b. Enter the file name for the exported file.
c. Select the Save button to create the new file, or select the Cancel button to stop
the export process.
17

BuildTopia — the most widely used web-based construction management software for homebuilders.



BuildTopia

Third Party Resources

Accounting with QuickBooks Pro - For Home Builders and Remodelers
By Diane C.O. Gilson

Available at www.builderbooks.com

Description: BuildTopia customers have found this book very useful in defining their data
structure in both BuildTopia and QuickBooks and recommend it to other BuildTopia customers
implementing either or both BuildTopia or QuickBooks.

Cardamel Consulting
Noelle Marshall, Certified QuickBooks Consultant
720-339-0624

www.cardamel.com

nmarshall@cardamel.com

Description: Cardamel is an established consultant providing Homebuilding Business Solutions.
Cardamel is a reseller of Microsoft Dynamics, BuildTopia, and Intuit QuickBooks. The
employees and partners of Cardamel have over 25 years of experience within the Homebuilding
Industry. Noelle Marshal, Cardamel’s Certified QuickBooks Consultant, has a thorough knowledge
of BuildTopia, QuickBooks and how they are best deployed together.

SMA Consulting
Steve Maltzman, CPA, President
909-420-0200

www.smaconsulting.net

smaltzman@smaconsulting.net

Description: SMA is an established consultant in the Industry providing excellent conferences
and consulting services relating to best practices for Home Builders. Steve Maltzman is also an
expert with QuickBooks and is a resource to better understand how QuickBooks can be optimized
in a Residential Construction Business.

NAHB Chart of Accounts
www.nahb.org — search for “Chart of Accounts”

Description: Developed by CPAs specifically for home builders, remodelers, developers, and
commercial builders, the NAHB Chart of Accounts is the foundation of a well-organized
accounting system. Use it to classify financial accounting data as assets, liabilities, owners’
equity, revenues, and expenses. The Chart of Accounts’ detailed subsidiary ledgers will structure
your managerial accounting system and organize data for analysis, reporting, and control.

NAHB Chart of Accounts (MS Word Document)
Part A: Outline of NAHB Chart of Accounts (MS Excel File - easy-to-import)
Part B: The Complete NAHB Chart of Accounts (MS Excel File - easy-to-import)

w0 Dnp P

Part C: Basic Accounts for Small Volume Builders (MS Excel File - easy-to-import)
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5. Part D: Direct Construction Costs Subsidiary Ledger (MS Excel File - easy-to-import)
6. Part E: Indirect Construction Costs Subsidiary Ledger (MS Excel File - easy-to-import)
7. Part F: Land Development Costs Subsidiary Ledger (MS Excel File - easy-to-import)

Accounting and Financial Management — For Residential Construction
By Emma Shinn

Available at www.builderbooks.com

Description: Maximize your financial performance! A solid resource for any builder, developer,
or contractor involved in residential construction, this revised and expanded fourth edition
provides an understanding of how and accounting system operates and the basic principles for
processing financial data.

BuildTopia — the most widely used web-based construction management software for homebuilders.
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Appendix A: LinkTopia Export Data Definitions
The following tables represents two different LinkTopia formats defining how each field within
the LinkTopia export file maps across BuildTopia and QuickBooks.
QUICKBOOKS - BT 5.5 (Default Linktopia export structure for Quickbooks prior to the 5.6 Release)
QB Header LinkTopia Export QB Header LinkTopia Export

(PO Header Line) (PO Line Item)
ITRNS TRNS ISPL SPL
TRNSID << BLANK >> SPLID << BLANK >>
TRNSTYPE |BILL TRNSTYPE |BILL
DATE APPROVED DATE DATE << BLANK >>
ACCNT AP ACCOUNT (as defined in Quickbooks ) ACCNT WIP ACCOUNT (as defined in Quickbooks )
NAME VENDOR ACCT CODE (or if blank, Vendor Name) NAME LOT ACCT CODE (or if blank, Lot Number)
CLASS << BLANK >> CLASS PROJECT ACCT CODE
AMOUNT _ |INVERSE PO TOTAL AMOUNT* AMOUNT  |[TOTAL AMOUNT
DOCNUM _ |PO NUMBER DOCNUM  |<< BLANK >>
MEMO LOT NUMBER + PO DESCRIPTION MEMO PO DESCRIPTION
DUEDATE [<< BLANK >> INVITEM COST CODE ACCOUNTING CODE (or if blank, CC Name)

*Inverse PO Total Amount = - (Total Amount) QNTY QUANTITY
PRICE UNIT PRICE
*Total Amount = Quantity x Unit Price

QUICKBOOKS - QB A 007 (Default Linktopia export structure for Quickbooks following the 5.6 Release)
QB Header LinkTopia Export QB Header LinkTopia Export

(PO Header Line) (PO Line Item)
ITRNS TRNS ISPL SPL
TRNSID << BLANK >> SPLID << BLANK >>
TRNSTYPE |BILL TRNSTYPE |BILL
DATE APPROVED DATE DATE << BLANK >>
ACCNT AP ACCOUNT (as defined in Quickbooks) ACCNT WIP ACCOUNT (as defined in Quickbooks)
NAME VENDOR ACCT CODE (or if blank, Vendor Name) NAME LOT ACCT CODE (or if blank, Lot Number)
CLASS << BLANK >> CLASS PROJECT ACCT CODE
AMOUNT _ |INVERSE PO TOTAL AMOUNT* AMOUNT _ [PO LINE TOTAL AMOUNT*
DOCNUM |PO NUMBER DOCNUM  |<< BLANK >>
MEMO LOT NUMBER MEMO PO LINE DESCRIPTION
DUEDATE |<< BLANK >> INVITEM ACCOUNTING CODE 1 (or if blank, CC Number)

*Inverse PO Total Amount = - (Sum of all PO Line Total Amounts) QNTY QUANTITY
PRICE PO LINE UNIT PRICE
*PO Line Total Amount = Quantity x PO Line Unit Price
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Appendix B: Bookkeeping Workflow Diagrams
Core Process: Basic Builder Bookkeeping
. . . . Accountin .
Financial Event BuildTopia 9 GL Entries
System
Direct Costs >
(Plumbing, Carpentry) Approve PO in
BuildTopia
Account
o Payable
$100 $100
PO’s
v
Match & Enter AP
Entries
Indirect Costs >
(Utilities, Permits)
Account
W Payable
$101 $101
Approve & Enter
AP Entries
Allocated Costs
(Dumpsters) >
Account
W Payable
$102 $102
Approve & Enter
AP Entries
(Allocate across
lots in project)
Deposits
Earnest Money, Option? Sales Rep Records
Deposit
Deposit
Bookkeeper_ enters Caeln Liabilit;
it $103 $103
Deposit
Reconciliation
Report
Construction Loan
Construction Loan Bank
- Draw Deposited Cash Liabilit
$10,000 | $10,000
Trial Balan
1al bajance > Trial Balance (related accounts)
Debit (DR) Credit CR)
Assets
Cash $ 10,103
Work in Process (WIP) $ 303
Liabilitites
Accounts Payable $ 303
Deposit Liability $ 103
Bank Liability $ 10,000
Total $ 10,406 $ 10,406
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Core Process: Basic Builder Bookkeeping - Closing Entry
Financial Event BuildTopia Accounting GL Entries
System
House Closing >
(Traditional Financing) Settle Lot in Buyer/Lot Sample Settlement Proceeds
BuildTopia Settlement
Base House Revenue $ 1,150,000
Options Revenue $ 512,366
HOA Fee Reimbursement $ 1,750
Receiv; — Real EstaFe Taxes $ (1,067)
Proceeds from the || COnstruction Loan Payoff $ (928,014)
Bank & Payoff Bank Fee $ (25)
Construction Loans | | Base House Deposits $ (20,000)
Option Deposits $ (134,662)
Settlement Costs $ (2,016)
Y ABC Warranty $ (2,003)
Closing Entry to Broker Commission $ (33,241)
book Revenue and | | Closing Cost Credit $ (6,000)
Cost of Sales Settlement Proceeds $ 537,088
Y
Closing Entry - Sample House
Sample Settlement Proceeds GL Account Debit (DR) Credit CR)
Base House Revenue $1,150,000 Base House Revenue Revenue $1,150,000
Options Revenue $ 512,366 Options Revenue Revenue $ 512,366
HOA Fee Reimbursement $ 1,750 WIP - Indirect Construction Costs  Asset $ 1,750
Real Estate Taxes $  (1,067) COS - Indirect Costs Expense $ 1,067
Construction Loan Payoff $ (928,014) Construction Loan Liability $ 928,014
Bank Fee $ (25) COS - Indirect Construction Costs Expense $ 25
Base House Deposits $ (20,000) Deposits Liabilty $ 20,000
Option Deposits $ (134,662) Deposits Liability $ 134,662
Settlement Costs $ (2,016) COS - Settlement Costs Expense $ 2,016
ABC Warranty $  (2,003) COS - Indirect Construction Costs Expense $ 2,003
Broker Commission $ (33,241) COS - Commissions Expense $ 33,241
Closing Cost Credit $  (6,000) Closing Credits Expense $ 6,000
Settlement Proceeds $ 537,088 Cash Asset $ 537,088
Other Journal Entries
Cost of Sales - Finished Lot Cost Expense $ 344,545
WIP - Finished Lot Cost Asset $ 344,545
COS - Direct Construction Costs Expense $ 462,809
WIP - Direct Construction Costs Asset $ 462,809
COS - Option Costs Expense $ 377,000
WIP - Option Costs Asset $ 377,000
COS - Indirect Costs Expense $ 34,610
WIP - Indirect Costs Asset $ 34,610
COS - Financing Costs Expense $ 11,000
WIP - Financing Costs Asset $ 11,000
Total $2,894,080 $2,894,080
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Core Process: Basic Builder Bookkeeping - Unit P&L
Financial Event BuildTopia Accounting GL Entries
System
Generate P&L >

P&L (Impact from the completion of a single lot)
Revenue

Base House Revenue $ 1,150,000

Options Revenue $ 512,366

Total Revenue $1,662,366
Cost of Sales (COS)

Direct Construction Costs $ 462,809

Option Costs $ 377,000

Finished Lot Cost $ 344,545

Indirect Costs $ 37,705

Commissions $ 33,241

Financing Costs $ 11,000

Closing Credits $ 6,000

Settlement Costs $ 2,016

Total Cost of Sales $1,274,316
Gross Margin $ 388,050

23%
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